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Introduction

RF Editor is a drag and drop graphical spectrum editing tool that allows easy modification of I1&Q signals of any
length. It also provides the ability to combine spectrum files in the time and frequency domains to create custom
spectrum specifically suited to an application. This demo guide present exercises that illustrate numerous RF Editor
functions in a self-guided format. To take best advantage of this guide, readers should familiarize themselves with
the operation of Spectro-X; a spectrum visualization and analysis software tool that can be downloaded from the X-
COM website (www.xcomsystems.com). Also available on the web site is a demo guide for Spectro-X.

RF Editor provides a broad range of frequency domain modifications, and can specify the relative time position of
each spectrum segment that will be combined in to a new, single spectrum file. Ten tracks are available for time
domain positioning, working in a manner directly analogous to audio and video editing tools. This allows a precise
selection of the start and stop time of each waveform segment. Also, it displays how they overlap and combine in
the frequency domain. The duration of recorded data can be shortened or lengthened; segments can be concate-
nated, filtered and shifted in frequency.

Once all waveform segments are placed in the time domain, a new composite waveform file can be built, named and
stored with a single mouse click. Transferring the files to Spectro-X for viewing and analysis is as simple as selecting
the waveform in the RF Editor library and clicking a radio button in the intuitive graphical user interface.

RF Editor’s Advanced Modify functionality allows single editing operations to be grouped and performed simultane-
ously. With this feature, functions that shift frequency, perform file decimation or interpolation by any integer value,
apply a filter with a bandwidth as narrow as 10% of the signal span and add attenuation or gain can be combined. A
single mouse click then applies these functions to either an individual spectrum file or a group of them.

Autoscaling of files in a group is also available. This is extremely useful when the file will be used to drive a vector
signal generator and one wishes to maximize the VSG’s DAC dynamic range.

An additional feature explored in this demo guide is the application of a linear amplitude ramp to the beginning or
end of a spectrum file. This feature can be extended in application to minimize the frequency domain impact of
what would otherwise be abrupt time domain transitions where segments are concentrated as a way of extending
their time duration.
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Installing the Demo

Downloading the Demo from the Internet

1. Inaninternet browser, go to:
www.xcomsystems.com

2. Go to Applications & Products > Products > RF Signal Generation & Analysis.
3. Click on the RF Editor, Graphical RF Signal Editor (WC-RF-EDITOR).

Figure 1 RF Signal Generation & Analysis Webpage
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Applications and Products > Products > RF Signal Generation & Analysis
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4. Onthe RF Editor webpage, go to the Downloads section on the right side of the page
and click on Download RF Editor.

Note: Registration will be required to download RF Editor.
Figure 2 RF Editor Product Webpage
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& Related Products
RF Editor, Graphical RF Signal Editor
RF Editor is a drag-and drop graphical editing tool that lets you easily modify 1&Q signals of any
length or create entirely new ones. It's an invaluable tool for modifying and building signal waveforms in
the time and frequency domains and is integrated with X-COM's Spectro-X signal analysis software.

CLICK HERE

1QC-2110 RE
RF Editor’s utiity spans defense applications such as creating simulated signal threat scenarios, to Capture and
Iaboratory. production and field testing of communications, EW, and radar systems using custom Storage

2L Enaroe stimulus signals

Flexible, Versatile Editing

RF Editor lets you make a broad range of frequency domain signal modifications and move any signal
or slice of spectrum anywhere among 10 time domain tracks in the recording, creating a new.
recording designed to accomplish specific goals. Snippets of recorded data can be dragged and

SpectioX Signal
dropped onto any of the tracks, and can be repeated, lengthened or delayed. filtered, and shifted in Analysis Toolkit

Download RF Editor

Graphical RF Signal Editor
Part # WC-RF-EDITOR

Once all waveform segments are in place, a new composite waveform file can be built with a single
mouse click. Using the fles in Spectro-X is as simple as selecting the waveform in the RF Editor fle PG-2110
list. and with a single mouse click bringing the entire file or a portion of it into Spectro=X for viewing Continuous
and analysis Pla

User Manual

Self Guided Demo

e Designed for Efficiency and Versatility
The software's Advanced Modify window allows operations to be performed sequentially and
automatically. Within this window. you can shit frequency. perform file decimation by any integer
value, apply a fiter with a bandwidth as narrow as 10% of the decimated signal span, and interpolate a
new span to adjust occupied bandwidth. Along with the flexibilty to align the frequency domain
modified fles on 10 different time tracks, RF Editor is unsurpassed in efficiency when creating custom
waveforms for specific applications and needs

An Integral Part of the X-COM Family

RF Editor can work on files from X-COM's IQC-2110 RF Capture and Storage System, hardware from
other manufacturers, or waveform segments created from MATLAB. Once modified in RF Editor and
analyzed in Spectro-X. they are available to be sent to -COM's CPG-2110 Continuous Playback
Generator for canversion to analog form and input to a vector signal generator for output at a desired
frequency range
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5. On the Download Software webpage, click on Register to Download.

Figure 3 Download Software Webpage
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Register to download the 30-day trial versions of X-COM Systems’ RF Data Analysis Software. These tools which offer the abilty to analyze, create and modify large data
sets. Whether you are analyzing long periods of recorded RF data or needing to create complex scenario testing, X-COM offers easy to use software tools to match your
needs

CLICK The software will work with industry-standard data formats such as XIQ. TIQ, mat, txt, and _bin, and is fully functional with a 30 day trial license. User manuals and seff-
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6. Onthe Download Registration webpage, fill out the form and click Submit.

Figure 4 Download Registration Webpage
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7. Once the form has been submitted, on the Registration Complete webpage, click on
Download Software.
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Figure 5 Registration Complete Webpage
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8. On the Resource webpage, click on RF Editor, Graphical RF Signal Editor.
Figure 6 Resource Webpage
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9. On the RF Editor, Graphical RF Signal Editor webpage select RF Editor (full function
30-day trial).

10. Follow the instructions for download.

11. Once the program has been downloaded, click on Download RF Editor Sample Files.

12. Follow the instruction for download.

Note: The files will be stored in:
C:\Libraries\Documents\X-Com\RF Editor\Sample Files.

Figure 7 RF Editor, Graphical RF Signal Editor Download Webpage
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Resource > Select Software > RF Editor, Graphical RF Signal Editor

RF Editor, Graphical RF Signal Editor a

RF Editor, Graphical RF Signal Editor is a graphical signal editing tool that allows the user to manipulate | & Q signal fles using the same drag and drop methods found
CLICK in music or video editing software applications. User Manual, Datasheet and Seff-Guided Demo can be found on the RF Editor produst page

HERE \> + RE Editor full function 30-day tial) - il size: 35 MB

Sample Files
Also included are sample files which can be downloaded and used with the RF Editor, Graphical RF Signal Editor. These files are referenced in the RF Editor, Self-

CLICK Guided Demo
H ERE \> + Download RF Editor Sample Files - zip file size: 24 MB

N ; « testsweep_lxg * Wiklax_1951GHz_110MHz_Lxig
Riar S0 el i + testSweep_Qxiq « Willax 1951GHz_110MHz_Qxia
o Ragar 30MHz {MeERIEQG + RF Editor Stiching doc * Wiklax_1962GHz_110MHz_1xi
*Radar 301Hz_15000000 BW 100ms_carsrch 9 + Wila1 Sb7GH— oM
 Radar _30MHz_15000000 W 100ms_lyia « Wiliax_1.873GHz_110MHz_Lxiq

« Radar_30MHz_15000000 BW 100ms_Qiq W ot oM
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Loading the Demo from the CD

1. Insert the CD into the CD drive of the computer.
Note: The CD will automatically launch the install program.
2. Click on the Install RF Editor at the top of the screen.

Figure 8 CD Launch Screen

Part No. 7105A990 - Spectro-X, Signal Analysis Toolkit/ RF Editor, Graphical RF Signal Editor CL'CK

party sofware It is particulary wellsuited for periorming these tasks on signal capture files offong duration that can be up o several days
in lengih, a procsss that vithout Spectro-X would be extraordinariy difcult and time-consuming

Simuitaneous, mult and corelation

Three dimensional plots show power, fiequancy and tims or
magnitude, frequency and persistence

Search for carters, standard wavaforms or arbitary waveforms

Click and drag zoom function quickly displays details of spectrum.
Un-zoom with one mouss click

Visual summary of entirs capture s and zoom box auickly.
identies time segment of nterest fo analysis

Autoscaling maxinizes display window viewing range

RF Editor, Graphical RF Signal Editor is 3 drag-and drop graphical editing tool that lets you easily madfy 18Q signals of any length or
create entirely naw ones. Ifs an invaluable toolfor macifying and building signal waveforms i tha fime and frequency domains and is
integrated with X.COM' Spectro-X signal analysis softwars.

RF Editor’s utity spans defense applications such as creating simulated signal threat scenarios, to labaratory, production and field testing
of communications, EW, and radar systems using custom stimulus signals.

Quickly build signal libraries using menu-driven iters, decimation
and interpolation, and frequency.shifing functions

e Build custom waveforms using search results fom Spectio-X. Select
non-contiguous waveform segments fiom search resuits and stitch
s them into a custom viaveform
o Change time duration and time track position of waveform segments
vith drag and drop mauss opration and simple menu inputs:
e Use spectrum stored in X-COM's 1QC-2110 RF Capture and Storage
ey System, hardware from other companies, of user-created waveform.

segments from MATLAB

x-com )
123458 Sunrise Vally O 087 / Fax: 703-350- 1085
Comyant 2012 gird

Click on Install RF Editor, Graphical RF Signal Editor.

Follow the instructions to install the program and demo files.

Click on Sample Waveform Set.

Follow the instructions to install the program and demo files.
Note: The files will be stored in:
C:\Libraries\Documents\X-Com\RF Editor\Sample Files.

Figure 9 RF Editor Screen

o u e w

RF Signal Generation & Analysis Software

-COM Systems, RF Data Analysis fer the abilty to anal te and modify large data sets

RF Editor ver. 2.7.2.5 (9900-0030-6004-1)

CLICK
HERE

RF Editor [Installation and Documents]
Install RF Editor. Graphical RY Signal Editor (ver. 2725}
RE Editor. User Manual (PDF)

RE Editor. Seff Guided Demo (PDF)

RF Editor [Sample Files]

Demo sample files which can be downloaded and used with the application. These
fils are referenced in the RF Editor Seif-Guided Demo

‘Sample Waveform Set

« Radar _30MHz TmsPRI (1 Q.xiq)
+ Radar _30MHz_15000000 BW 100ms ( carsrch, | & Q xiq)
* testSweep (I & Q.xiq)

« Wiklax_1.951GHz_T10MHz (1 & Q.xiq)

« Wilkax_1.962GHz_110MHz (1 & Q xia)

« Willax_1.973GHz_10MHz (1 & Q.xio)

« RF Editor Stitching doc

System Requirements

PC vith Windows 7 (32-bit/64-bit)
1GB RAM & Pentium IV or Equivalent Dual-Core Processor
(268 or more Recommended)
800 x 600, 256 Color Display
(1280 x 720, 16 Bt or Higher Resolution Recommended)

Mouss or Trackpad
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Waveform Library

RF Editor files consist of an I/Q pair with file names ending _I.xiqg and _Q.xiq respectively. Typically, RF Editor looks
for the C:\IQCFiles directory upon installation. If that directory cannot be found then it defaults to the root directory.
The files list shows all data files with matching |/Q pairs in the default directory with a matching span or sample rate
equivalent to the Span selected in the Span drop box.

Figure 10 Waveform Library

r
2 RF Editor

E File Edit Build Help

Refresh File list | Show Cnly Matching Spans Sta

testSweep i
WiMax_1.951GHz_110MHz
WiMax_1.962GHz_110MHz
WiMax_1.973GHz_110MHz

Tr

Tr

Tre

Tr

Changing | and Q Directories

Note: For this procedure, refer Figure 11 on page 8.

1.

v W

Go to Edit in the Toolbar at top of the window.

Select Settings from the drop down menu.

Click on Browse.

Locate and click on the correct | directory.

Do one of the following:

® |f Q directory is the same as | directory: Click on Match Q directory to I.

® |f Q directory is not the same as | directory: Repeat Steps 3 - 5 for the Q directory.

Note: By default, the | and Q files reside in the same directory. With the
“Match Q directory to I” box checked, any changes to the | directory will auto-
matically be reflected in the Q directory as well. Uncheck the “Match Q directory
to I” if the I and Q files are in different directories or drives.

Click on Save.
Click on the Refresh File List button.
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Figure 11 Settings Dialog

E3 RF Editor

File | Edit | Build Help

Settings Shomw

AR R

| Direciony:  C\Users\dkoger\Documents'X-Com'\AF Edfor\Sampls Fles

[+] Matich Q dinectory ta |

Q Direclory: | C:\Users’dkoger'Documents'-Com'\AF EdiorSample Files

L v Librares + Documents » X-Com » RF Editor » Sample Files

Organize = Mew Folder

U Faverites . Documents library
B Desktop Sample Files

i Uonnioads Marne Date modified Type Size
W Recent Places
2 My Site = _ testSweep Laig 1 K1) File 5 KB
testSweep_Quiq 1 %163 File 5 KB
“4 Libraries Wilan 1 951GHz L10MHz Leig 2716/, #163 File 2546 KB
*| Documents Wiblax 1 851GHz_110MHz_ Qg 2 #13 File 2046 KB
o Music — Wibax_1.562GHz_110MHz Lxig K3 File 2,546 KB
kS| Pictures Wila 1 562GHz_110MHz_Qxig X1} File 2546 KB
H videos Wiban_1 5T36Hz_110MHz_Lxig K1) File 2546 KB
Willan_1 573GHz_110MHz_Quxig %10 File 2546 KB
% Computer
&, osDisk (C)
9 graphics \\bird\public) (G
59 hede_a (\\bird\ public) (H)
= Removable Disk [} 5

File name: v | Select Directary -

Note: Ifthere are issues with files not appearing in the list, uncheck the “Show
Only Matching Spans” box to see all I/Q file pairs in the selected directory.

Frequency Span

If the Span drop box does not match the span of the desired file, you need to change the Span. If your files are not in
the default directory, you must change the directory to the location of the files.

Changing Frequency

Do one of the following:

To change the Span drop box you can either
® Enterin the new span

® Select a span from the drop down list
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Figure 12 Frequency Span Drop Box
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Creating a WiMax 1ms Long Short Version

This exercise demonstrates how to use RF Editor to shorten a file’s duration and how to combine multiple files in the
frequency domain.

1. Configure the following settings (refer to Figure 13):
a. Operational Mode: Tektronix
b. StartTime: 0
End Time: 0.01
d. Span: 110 MHz

Figure 13 Configuration

Stepb Stepc Stepd Step a
el '\ \\ \\ [
o A \é- Tektronix
Stat Time 0 End Tme 0.01 span TIOMHZ  ~  gopic Rate: 150 MH: b e Snap To Giid

e 1 i i 1 i i i
Drag-and-drop WiMax_1.951GHz_110MHz on Track 1 starting at 0.0.
Right-Click the blue label on Track 1 to bring up the Edit File Screen.
Uncheck the “Maintain Width” checkbox.
Enter 0 in the “Start On Track” field.
Enter 0.001 in the “End On Track” field.
Click on the “Done” button.
Select Build RF File from the Build Menu.
Enter WiMax_1.951GHz_short in the filename field and click on the OK button.
10 Select “New RF Worksheet” from the File menu.
11. Repeat steps 2-8 for WiMax_1.962GHz_110MHz.
12. Enter WiMax_1.962GHz_short in the filename field and click on the OK button.

© 0NV AWN
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Using Filters

13.
14.
15.
16.

17.
18.
19.
20.
21.
22.
23.
24,
25.
26.
27.
28.
29.

Select “New RF Worksheet” from the File menu.
Repeat steps 2-8 for WiMax_1.973GHz_110MHz.
Enter WiMax_1.973GHz_short in the filename field and click on the OK button.

View each of the files in Spectro-X to see the frequencies for each. Refer to “View
Newly Created Signals Using Spectro-X” on page 11.

Go to File>Select>New RF Worksheet.

Set End Time to 0.01 seconds.

Drag and Place WiMax_1.951GHz_short _110 MHz on Track 1 starting at .001 seconds.
Drag and Place WiMax_1.962GHz_short_110 MHz on Track 2 starting at .002 seconds.
Drag and Place WiMax_1.973GHz_short_110 MHz on Track 3 starting at .002 seconds.
Right-click on the WiMax_1.973GHz_short_110 MHz blue button to bring up the Edit File.
Set the Start on Track to 0.0021.

Check the Maintain Width checkbox.

Click on the “Done” button.

Select Build RF File from the Build Menu.

Enter WiMax_Test01 as the filename.

Click OK on the Build Module screen.

Check the file that was created in Spectro-X. Refer to “View Newly Created Signals
Using Spectro-X” on page 16.

This exercise will filter a spectrum file and remove the lower spectral component. The graphic below shows the fil-
tering characteristics of the Band Pass filter that will be used in the exercise.

Figure 14 Filter Characteristics

NoE

©® Nk w®

RF Editor Band Pass Filter Characteristics (Invert for Band Stop)

(-a/2) Hz (a/2) Hz

-aHz +a Hz

0 Hz

a = Filter percentage * file sample rate (Hz)
Change the Span to 110 MHz.

View the WiMax_1.973GHz_short in Spectro-X. Refer to “View Newly Created Sig-
nals Using Spectro-X" on page 11.

Click on the WiMax_1.973GHz_short to select the file.
Click the Modify File button to open the Modify File dialog.
Enter WiMax_1.973GHzShort_HighOnly in the New File Name Field.
Select “Filter File (Band Pass)” in the Modify Field.
Select the filter of “60 MHz bandwidth”.
Enter 10 MHz for the Start Frequency.
Note: 70 MHz will automatically be entered for the End Frequency.

Click on Create File button.
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Figure 15 Modify File, High Band Pass

E3 Modify File o o S

File Name: WiMax_1.973GHz_short
New File Name:  Wilax_1.973GHz_HighOnly
Span 10 MHz Sample Rate: 150 MHz
Modify: Filter File (Band Pass) -

Band Pass Filter: d

Start Frequency 10 MHz

End Frequency 70 MHz

| Exit | ‘ Create File ‘

10. Check the file in Spectro-X. Refer to “View Newly Created Signals Using Spectro-X” on
page 11.

Figure 16 WiMax 1.9763 GHz Waveform (before filtering)
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Figure 17 WiMax 1.9763 GHz Waveform, Band Pass Filter (after filtering)
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Changing the Span
1. Open anew RF worksheet.
2. Click on the WiMax_1.973GHz_short to select the file.
3. Click the Modify File button, at the bottom of the RF Editor window, to open the
Modify File dialog.
4. Enter WiMax_1.973GHz_short_1.2GHz in the New File Name Field.
5. Select “Change Span (Change the Sample Rate)” in the Modify Field.
6. Select a New Span of 1.2 GHz.
7. Click on Create File button to begin.

Figure 18 Modify File

10.

11.

E3 Medify File o [ 5 [ |

File Name: WiMax_1973GHz_short

New File Name: ~ WiMax_1.973GHz_short_1.2GHz
Span: 110 MHz Sample Rate: 150 MHz

Modify: Change Span (Change the Sample Rate) -

New Span: 12GHz ~  Sample Rate: 300 MHz

Create File

Click on Span to open the drop down menu.
Change Span to 1.2 GHz.
Click on “WiMax_1.973GHz_short_1.2GHz".

Note: If the file does not appear in the Waveform Library, click on “Refresh
File List.”

Check the file in Spectro-X. Refer to “View Newly Created Signals Using Spectro-X” on
page 16.

Note: It should look similar to the Spectrogram in Figure 19.
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Figure 19 Change Span Waveform
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Move the -28MHz WiMax Signal in WiMax_1.973GHz_110MHz_Short to +30MHz

1. Create a new worksheet.

2. Click on WiMax_1.973GHz_110MHz_Short in the file list.

3. Click on the Modify File button below the file list to bring up the Modify File dialog.
Figure 20 Modify File

Mty Fi s Header

Sericl 3 Spectss-X

4. Use WiMax_1.973GHz_110MHz_Shifted for the new file name.
5. Select Frequency Scale (Shift all Frequencies within the Span) from the Modify pull-down.

Note: We want to move the -28MHz signal to +30MHz so we need to shift the
signal 58MHz so we need to enter 58MHZz in the Frequency Shift Field.

Figure 21 Modify File Dialog

E3 Modiy File o |
File Name: Wibax_1.973GHz_110MHz_Short
New File Name:  WilMax_1.973GHz_110MHz_Shot_CS
Span Sample Rate: 150 Wiz
Modity Frequency Scale (Sh# all Frequencies within the Span)
Frequency Shift (Hz): 58 MHz
Exit Create File
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6. Click on the Create File button to build the shifted file.
7. Check out the results in Spectro-X.
8. Expand the frequency settings to the Nyquist limits:

a. Click on Playback>Control>Frequency Settings.

b. Set the following:
®Start: -75 MHz
®Stop: 75 MHz

Note: Inthe mathematical equations, one cannot simply push the upper signal component of the original
spectrum off the end of the frequency limit. Those frequencies will wrap around in both directions. In this
case, the upper component originally located at +28MHz is also shifted by 58 MHz to +86MHz, but the upper
Nyquist limit has been set to +75MHz. Therefore, the +28Mhz wraps around to the lower level of -75MHz
+11MHz to a new location of -64MHz. This could then be filtered if desired.

Also, note the dropout in the noise floor from about -30MHz to about OHz. This is created from the analyzer’s
filter when the signal was captured.

Figure 22 Spectro-X Reading
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Creating a 100ms Long Output File

This exercise utilizes a 2 ms segment of a file that is 10 ms in length to create an output file that in 100 ms in total
length. RF Editor will create 50 copies of the 2 ms segment to generate the output file.

Note: Use WiMax_1.951GHz_110MHZz I/Q file pair. It can be found in the zip file on the X-Com Systems website.
This file is 10ms long and has a bandwidth of 110MHz with a WiMax signal at approximately 48MH:z.

1. Select the appropriate directory for the file.

Select 110MHz Span.

Set Start Time to 0 seconds.

Set Stop Time to 1 second.

Click on the WiMax_1.951GHz_110MHz file in file list.

Drag and drop WiMax_1.951GHz_110MHz on to Track 1 at O seconds.
WiMax_1.951GHz_110MHz is only 10ms in length so it appears as a very thin line.

Change the Stop Time to 0.1 seconds and WiMax_1.951GHz_110MHz will be repre-
sented much larger on Track1.

Figure 23 Track
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Track 1
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9. Right-click on the blue box that represents WiMax_1.951GHz_110MHz to bring up
the Edit File dialog box.

Note: A 2 mssegment will start at 6 ms into the file and ends at 8 ms into
the file and then loop it 50 times to create a 100ms long output file.

Figure 24 Edit File

Edit File = | )
File Name: WiMax_1.951GHz_110MHz
File Duration: 10 ms
StartinFile: o0s
EndiInFile: 10ms
Track: 1
Start On Track: 0 [T Maintain Width

End OnTrack: 10 ms

Ramp InfOut (Samples): o
Repeat Ramp (Samples): o

Aftenuation/Gain: 1

Attenuation File

Attenuation Sample Rate: 0 Hz

10. Set the Start In File to 0.006 seconds.
11. Set the End In File to 0.008 seconds.
12. Uncheck the Maintain Width checkbox to allow you to extend the signal across 100ms.

Note: This will allow the selected data in the file between 6ms to 8ms to cor-
rectly fill the time that you will select for the track.

13. Set the Start On Track to 0 seconds.

14. Set the End On Track to 0.1 seconds.

15. Hit the Done button to activate the changes.

16. Build the file by selecting the Build RF File option from the Build men.

Figure 25 Build RF File Menu

RF Editor
File Edit | Build | Help
| RefleshF|  Build RFFile ans
WiMax_1.951 P
Willax 1,962 Stitch File
WilMax_1.973 Modify Groups of Files

17. Enter the name WiMax_1.951GHz_110MHz_Repeat50 in the RF Create File dialog box.
Figure 26 Create File Dialog

RF Create =2
Enter the File Name to Save

WiMax_1.8951GHz_110MHz_Repeat50

18. Click OK to build the file.
Note: The build dialog will show the build progress.
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Figure 27 Build Dialog

{ Build Signal |
Output Flename:  C:\Wsers\TroyCalderwood \Documents| ..
Busdd
Pass 1 -Read
- -
3 -
Pass 2 - Scale and Output
i
Q@
Time Elapsed: 0:0: 4

Estimated Time Remaining:  0:0: 6

Crveral Progress:

Close

19. Send the file to Spectro-X.

Note: Some frequency splatter at each repeated location will appear due to a
discontinuity at the head and tail junction. Refer to “Ramp Function” on page 21.

Figure 28 Spectro-X

Hagntucks (dB i

Time Orgin
00000003545

3 g R
Q0000

View Newly Created Signals Using Spectro-X

1. Ensure Spectro-X is installed, running, and set to accept Remote Connections.
Note: See Spectro-X user manual for proper connections.
2. Click on the desired file within the Waveform Library to highlight it.

Note: Ifitis not showing in the list, click on the “Refresh File List” button to
reload the directory.

3. Click on the “Send to Spectro-X” button.
Note: This will bring up the Spectro-X Control dialog.
4. Go to Spectro-X.
5. Click on the Play button in Spectro-X to start the playback of the file.

Note: It isimportant to know the signals before beginning to modify or combine waveform segments. Cre-
ating a plan or storyboard before beginning to build RF signals is advised.
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Change Test Sweep from 110MHz Span Down to 40MHz

This exercise illustrates how to resample, in this case, decimate a file to reduce its frequency span.
1. Create a new worksheet.
Look at testSweep in Spectro-X.
Ensure the frequency sweeps from about -45MHz to +45MHz.
Select testSweep and click on the Modify button.
Use testSweep_40MHzResample for the new file name.
Select Change Span (Change the Sample Rate) for the Modify pull-down.
Select 40 MHz for the new span.
Click on the Create File button to build the resampled file.
Look at the new file in Spectro-X.

WO NN WN

Note: The files are organized by Span or Sample Rate. A file with a Span of
40MHz has been created.

Figure 29 Span

I3 R Editor
Fike Edit Build Help
Fladrash Fis kst ) Show Orly Matching Spans St Tme 05 EndTme 10s T ) MHz] -
testSweep_40MHzFiterfissample Track 1 1 2z 3 1

testSweep_40MHzResample

10. Ensure the Span is changed to 40MHz.

Note: The entire sweep can no longer be accurately represented with a span
of 40MHz (sample rate of 50MHZz) so the data gets folded back in to the spec-
trum creating odd effects.

Figure 30 Spectrogram

Magnitude (dBm)

Relative Time (usec)

Time Origin
D00:00:0.000045

Freq Origin
100 MHz

Advanced Modify Function

This exercise uses the Advanced Modify functions to accomplish multiple modifications from one dialog box.
1. Select testSweep and click on the Modify button.
2. Rename the file testSweep_40MHzFilterResample.
3. Select Advanced from the Modify pull-down.
4. Click on the Create File button to build the resampled file.
Note: The raw XIQ Modify screen where you can combine many steps in series

will pop up. Run each operation by checking the box and entering the correct
parameters. Each operation is run sequentially to build the output file.
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Figure 31 Modify File Dialog

3 Modiy File (== pem |
File Name testSweep
New File Name:  testSweep_40MHzFilterResampia
Span MHz Sample ate: 150 MHz
Modify. Adanced
Eyit | Create Eile

5. Select the Filter checkbox and choose the 20% filter.

Note: This enables filtering 20% of the sample rate on either side of 0 Hz. In
this case that is 20% of 150MHz or 30MH: on either side of O for a total of
60MH:z of bandwidth.

6. Select the last Decimate checkbox and put a 3 in the Decimate field.

Note: This enables eliminating 2 out of every 3 samples in the data. In this
case, taking the sample rate from 150MHz to 50MHz and that is a 3 to 1 ratio.

7. Click on the run button to build the output.
Note: Processing will occur in the order selected.
8. Send the file to Spectro-X.

Note: To see the entire spectrum, set the start and end frequencies to -25MHz
and 25MH:z respectively.

9. Ensure the difference in the spectrum has virtually no inappropriate frequencies at
the beginning and end.

Figure 32 Advanced Modify File
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Figure 33 Spectrogram
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Use Modify Groups of Files to Increase the Sample Rates

Note: The files must have the same sample rate/span to be grouped together.
1. Setthe Span to 110MHz.
Figure 34 Build Menu

E3 RF Editor

File Edit | Build | Help

| Refresh B Build BF File 5
LTE EDGE G| ; i

ey Stitch File

WiMax_1951 Modify Groups of Files

Wibax_1 95 Vi5ve=

———

2. Use the Modify Groups of Files option from the build menu to get to the Modify File
Group screen.

3. Select the following from the file list:

WiMax_1.951GHz_110MHz_Short
WiMax_1.962GHz_110MHz_Short
WiMax_1.973GHz_110MHz_Short
WiMaxTest

4. Use _300MHz for the Add Text to File List field.
Note: This is what will be added to each file name to create the new file at the

new sample rate.

5. Select 300 MHz from the New Span pull-down.
6. Click the Create File button.
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Figure 35 Modify File Group Dialog

Xl Moty Fie Group =loEs
Fustowans Fle bt Somn
LTE £0GE GSM Wiy
e — File Name Example: LTE EDGE GSM WLANg

A _300MHz

iew Fie Name LTE EDGE GSM WLANg_300MHz

o : S Fse: 190 Mt

Moaty Ghange Span (Change the Sargle Rate)

New Span 300 MHz - Samla Rate: 300 Mz
Exit Create File

7. Exit the Modify File Group screen.
8. Set the Span to 300 MHz to see the new files in the file list.

Use the Edit Header Function to Change Frequency Origin

1. View WiMax_Test_300MHz in Spectro-X.
Note: The Frequency Origin should be OHz.

2. Highlight WiMax_Test_300MHz in the file list.
3. Click on the Edit Header button.

Note: BE CAREFUL, Changes made to the parameters of the data are perma-
nent. Be aware of the consequences of the changes being made.

Figure 36 Edit Header Button

Track 1

Mcaity Fla Edt Header

Sand b3 Spectss-X

4. Change Center Frequency to 1 GHz.
Figure 37 Edit Header Dialog

EJ Eclit Headler - Wikax_Test_300Mtz [F=31ch = |

Spn  J00MHz ~
Sample Rate
Center Frequency h GHz -
Scale Factor  4.856755e-010
RBW 0 MHz ~
File Format
Marker Size
Marker Count
Potect 0

Markars

Exit Wiite Header

5. Click on the Write Header button.
6. Check the results in Spectro-X.
7. Ensure Free Originis 1 GHz.

20
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Figure 38 Spectro-X Reading
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This function removes the frequency discontinuities and splatter observed where multiple copies of a spectrum clip-

ping were concatenated in to a

longer file consisting of repeated segments. The splatter at each segment end-to-

beginning transition point occurs because of the abrupt, time-domain file transition. Ramping can reduce the abrupt

transition in the time domain b

etween segments and therefore the number of frequency components necessary in

the frequency domain to reproduce the segment to segment transition.

1.

2.
3.
4

Drag and drop WiMax_1.95GHz_110MHz on to track 1.

Set RF Editor Start time to Osec and End time to 10 ms.

Right click on the blue representation of the waveform on track 1.

Set up the Edit file window as shown below (same as in "Creating a 100ms Long Out-
put File" on page 9.).

Enter “10,000” in the dialog box next to “Repeat Ramp (Samples).”

Note: By doing this, you are specifying the number of samples over which the
waveform amplitude is ramped down and then up, by approximately 60 dB, to
eliminate frequency splatter at the point of concatenation of waveform seg-
ments in the time domain.

Hit Apply and then Done.
Build the file and call it "WiMax_1.95GHz_110MHz_RptRamp".
Observe the file in Spectro-X.

Note: The ramp function can also be applied to the beginning or end of a sin-
gle spectrum segment by specifying the number of samples and therefore the
slope of the ramp attenuator in the Ramp In/Out (Samples) portion of the RF
Editor Edit File window.
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Note: Shown is a comparison of the spectrograms of the result of this file concatenation without (left spec-
trogram) and with (right spectrogram) the ramp function implemented. Notice the elimination of frequency

Figure 39 Edit File Window
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Figure 40 Spectro-X
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splatter at the transitions between waveform segments.
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Stitch Function

Using Spectro-X Search Results

Stitching is a process that concatenates segments of a spectrum capture file which have been selected by the user. It
effectively provides a way to cut out undesired portions of a file and reconnect the remaining segments.

Segments can be delineated in two ways. The first is via file markers inserted in the file during receipt and process-
ing, by the IQC5000A, of TTL level pulses presented to either of its two trigger input BNC connectors. Spectro-X
search results can also be used to denote segments.

Example - A carrier search is conducted in Spectro-X looking for carriers in a capture file
that exceed -40dBm in power and, using search pruning, have a duration not exceeding 50
microseconds (See Spectro-X User Manual and Spectro-X Self Guided Demo manual, both
available for free download at www.xcomsystems.com). Spectro-X can export the results of
this pruned search to a file that delineates each portion of the capture file in which these
user selected criteria have been met and in a manner usable by RF Editor.

RF Editor can utilize either type of segment designation; search results or markers in the Stitch Function. If RF Editor
stitches using markers then, the new file will contain the segments delineated by the markers and the segments will

be concatenated with no blank time between them. A stitched file using search results will result in something
slightly different.

Example - A capture file of 100 us in length is searched for carriers with the criteria of
power levels above -15dBm. Further, assume there are three time segments in which carri-
ers meet this threshold. The first segment occurs in the file from time 1 us to 5 us. The sec-
ond segment occurs during the file time from 10 us to 12 us and the third from 15 us to 25
us. If these search results are brought in to the RF Editor Stitch Function and the first and
third search results are checked as the ones to be stitched, then the resulting file will be
25us long. The first microsecond of the file will contain zeros (no spectrum). File time 1us
to 5 us will contain whatever was in the searched file during that time period. There will be

zeros from file time 5us sample to 15 us and it will contain whatever was in the searched
file from time 15us to 25 us.

The Stitching function can use the results from Carrier Search, Waveform Search, or Pulse Search. The time value
entered in the Offset field will be used to adjust the Start for each search result. Entering a negative value will back
the start in time. While Carrier Search and Pulse Search results contain durations, the Waveform Search results do
not. When using Carrier Search or Pulse Search results, the time entered in the Duration field will be added (use a
negative number to decrease the amount of time) to each result’s duration. When using the Waveform Search, the
amount entered in the Duration field will serve as the duration for each result.

Figure 41 Carrier Search

Stitch with 1GHz Multi Pulse [ ===
Carrier Freq (H2) Bandwidth (4z) start (sec) Duration (sec)  Power (dEm)

1. -1b7.200600000 bz 1.52531830000 MHz 30653 us iT.187  us

2. 0.500000000000 k2 1.52532550000 MHz 144,64 us 11147 us

3. 86.10000000000 Hz 1.52530270000 MHz 245,627 us 11147 us

4. 129.5000000000 k2 1.52533970000 MHz 352,613 us 11147 us

5. 13.5955732000 Mz 1.54535430000 MHz 56.6  us 6.307  us

6. -30.616982500 MHZ £,32454380000 MHZ 506.613 us 4,84 us Offset from Marker (seconds)
7. -25.843033600 Mz 1.86322740000 MHz 5116 us 132 us

8. 15.0197676000 MHZ 4.71580540000 MHZ 605.76  us 3.667  us Sus

S. 20.1500846000 Mz 5.50119490000 MHz 609,573 us 352 us

10, 25.0213317000 MHZ 4.95304810000 MHZ s13.24  us €453 us

11, 19.4507643000 MHz 5.51146760000 MHz 619.84  us 3.52 us

12 7 4.02366270000 Mz 623,507 us 3227 us

13, 1.54432820000 MHz 7 7 us 6.307  us Duration (seconds)
14 161199420000 Mz 517.693 us .08 us 10us

15 161243270000 MHz 913.613 us 3.227  us

1s. 1.61217580000 Mz 1.00%68 ms .08 us

17. 1.61209760000 Mz 11056 ms 3.227  us

18 161234030000 MHz 1.20166 ms .08 us

19, -19.999839400 MHz 1.61246690000 MHz 1.29758 ms 3.227  us

20. -15.559301500 Mz 161227070000 MHz 1.39365 ms 3227 us

21, -19.999879500 MHz 1.61280080000 Mz 1.48962 ms 3227 us

22, -20.000263000 MHz 161203870000 MHz 158569 ms .08 us

23, -20.000131700 MHz 1.61252620000 MHz 1.68161 ms 3.227  us

24, -20.000373500 MHz 161250830000 MHz 177768 ms .08 us

25, -19.999450300 MHz 1.61295200000 MHz 18736 ms .27 us

26. -15.559730400 MHz 161247250000 MHz 1.56966 ms 3,08 us Use Soarch Resats
Check Al Uncheck Al

Cancel Create File
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Figure 42 Waveform Search
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In the following exercise we will rapidly produce a custom waveform that consists of waveform segments which
were found to match specific criteria. The segments are part of a much more complex spectrum capture. Using
Spectro-X and RF Editor, we can quickly isolate only what we want and use those desired segments to build the exact
waveform we need without any custom code needing to be written.

1. Open Radar _30MHz_15000000 BW 100ms.xiq file in Spectro-X. Refer to “View
Newly Created Signals Using Spectro-X"” on page 11.

2. Use Carrier Search to find all signals above -45dBm.

Figure 43 Carrier Search Window

Search Results T |
Search Type. [Camer 5
Number of results. ']99—
Camer Frequency Bandwidth Stat Tme Duration Power =
99705H:  211.147kHz  120i8msec  18.773usec 26,09 dBm
30787H:  211505kH:  12227msec  17.600usec 30.86 dBm
-48.1936 Hz 211.2166kHz 13.019 msec 17.600 usec: -27.78 dBm
S75957H:  2102549kHz  14020msec  15253usec 3521 dém =
2535810H;  211563kHz  14227msec  17600usec  -30.57dEm
82088 Hz 2117846kH:  15020msec  14080usec 36.95 dBm
2692027H:  2109277kH:  15227msec  17600usec  2655dBm
472 835 Hz 210.8600 kHz 16.019 msec 17.600 usec -28.26 dBm
3108267H:  2110247kHe  16227mssc  18773usec  -26.26d
12378 Kz 2109343kHz  1668msec  1760usec 2833 dBm
-143 3452 Hz 2105714 kHz 17.228 msec 17,600 usec 28 86 dBm
614.2389 Hz 210.325 kHz 17.686 msec 15253 usec 37.17 dBm
25600kH:  2125446kHz  18230msec  12507usec 3329 dBm
526939H;  211837kH:  186%6msec  16427usec 3509 dBm
2933244 H:  2110654kHz  19228Bmsec  16427usec 52dBn
5643347 He 211.7995 kHz 19,686 msec 17.600 usec: -27.83 dBm
6304397H:  2110533kH:  2028msec  17600usec  27.26dBm
1857257H:  2111224kH:  20885msec  18773usec  -26.10dBm
S61139Hz  211263kHz  21.227msec  18773usec  26.10dBm
46 5646 Hz 211.074 kHz 21,685 msec 18773 usec 2742 dBm
S96881H:  2107422kH:  2227msec  18773usec  27.80dBm
T0817kH:  2112384kHe  22888msec  16.427usec 33,09 dBm
14290kHz __ 2116017kH: __ 23229msec___ 15253usec __3421dBm
20790 kHz_ 214,545 kHz 23 688 msec 11.733 usec_ -40.14 dBm
14977 kHz 213.7355 kHz 24 229 msec 14.080 usec -37.83 dém ;‘
Sort
Parameter Direction
Camer Frequency v @ Increasng Sot
© Decreasing
Save To File

Export the results to a text file by clicking on the Save To File button.
Ensure to save the file in a text format and not the binary format.
Name the file Radar _30MHz_15000000 BW 100ms_.carsrch.
Return to RF Editor.

Select the Agilent radio button.

Enter 15MHz for the span.

Note: Radar_30MHz_ 15000000 BW 100ms should show in your file list. If
not, you will need to find it by changing the directory in the Settings dialog.

® NV AW
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9. Inthe file directory window, highlight (left click) the file
“Radar_30MHz_150000000BW 100 ms”.

10. Go to Build>Stitch.

Note: The Stitch dialog window will appear.
Figure 44 Stitch File Dialog

Stitchwith Radar_30MHz_15000000 W 100ms

Cancel ate File Create Track

11. Click on the Use Search Results.
12. Select radar _30MHz_15000000 BW 100ms_.carsrch.
Figure 45 Use Search Results Window

|, « OSDisk (©) » Users » dkoger » Documents » X-Com » RFEditor » Sample Files

Organize > Newfolder

Ao ~ Name Date modified Type Size

[ Radar 30MHz 15000000 BW 100ms cars... 8/16/2012323PM  CARSRCHFile 9k8
18 Downloads

£ Recent Places

2 MySite

3 Libraries

[ Documents
& Music

(=] Pictures
B videos

% Computer
&, osDisk ()
9 graphics (\bird\public) (G:)
9 hede_a (\\bird\public) (H:)
@ drawinas N\bird\oublic) ():) i

File name:

13. Select the desired pulses by checking the box next to each signal.

Note: This example will create a signal that has pulses of a 1ms PRI.
14. Check the boxes next to (search result numbers) 8,9, 11, 13 and 15.

Note: Doing this, you are selecting search results whose start times are 1 ms
apart (3.22688 ms, 4.22538 ms ... 9.22613 ms). These are the search results that
the Stitch generator will use to create the new composite waveform.
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Figure 46 Stitch File Worksheet

E3 Stitch with Radar _30MHz_15000000 BW 100ms

Carrier Freq (#z)  Bandwidth (Mz)

332, 700000000 210. 527500000 Kiz
322. 5000000000 +z 210.913800000 kiz

Offset from Marker (seconds)

0

Duration (seconds)

]

Use Search Resuts

[(Creoch ] [Undescan]

‘ Cancel ‘ ‘ Create File ‘

Note: If needed, Offset from Marker and Duration fields give precise control
and adjustment of the start and end points. In a carrier search, the results con-
tain a duration so the Duration field is added to the duration. In search results
without durations, a positive value must be entered in the Duration field. Keep
in mind; both Offset from Marker and Duration can be either positive or nega-
tive in some situations. A negative value for Offset from Marker will make the
start point sooner that the Start value in the search results. A negative value for
Duration is valid only when using a carrier search and indicates the duration will
be less than the value returned from the search results.

15. Click on the Create File button to build the desired file.

Note: You now have built a file that only contains the search results you
wanted by placing check marks next to them in Step 14.
16. Name the file “Radar_30Mhz_1msPR1” using the Save dialog.
17. Click on OK to begin building the file.
18. Check the file in Spectro-X. Refer to “View Newly Created Signals Using Spectro-X” on
page 11.

Figure 47 Stitch File Spectrogram
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Start a new worksheet.

Set Analyzer Setting to Tektronix.

Change the Span to 2 Mhz.

Set the Start Time to 0 and End Time to 1.

Highlight Macro12 96MHz_2MHz_20100912_162349 | from the file list.

Note: This file was created by using the IQC5000A in conjunction with the RSA
spectrum analyzer. Seven 2MHz frequency bands were captured throughout the
FM radio spectrum by changing the center frequency of the spectrum analyzer
during the capture. The capture frequency starts at 95MHz and runs through
103MHz. After each step, the Forced Trigger function was used in the RSA to send
a trigger to the IQC5000A. This placed a marker in the data file at a point near
where the frequency has changed. The objective was to create a file that has 0.1
seconds of data with each frequency band captured. This gives a picture of the
static spectrum for each of these bands in a single file for a precise length of time.

Figure 48 RF Worksheet

3 RF Editor [=@)=

File
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z_20100912_130217 Track 3 ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘ ‘
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4GHz_2MHz_20110629_212601 Track 4 \ . \ \ \ ‘ \ \ ‘ ‘
49 - Span: 2 MHz - Duration: 12.0000512 |

TestMac02NoSleep_2 4GHz_2MHz_20110629_204455
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Tekio | \ \ \ \ \ \ \ \
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Select the Stitch File option from the build menu.

Note: The Stitch dialog will automatically load the markers and select all
markers except for the first and last. The first and last markers are automatically
generated with the capture while the remaining markers were generated during
the capture to mark each frequency change.

Uncheck the boxes for the first and last markers.

Note: Any of these markers can be removed by unchecking the box next to the
marker to give precise control over the file being built.

Set the Marker Offset to 0.001.
Set the Duration to 0.1.

Note: Duration must be set in the Duration field. Duration will determine how
much data to put in the output file.
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Figure 49 Stitch File Dialog
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Use Search Results

Create Track

10. Click on Create Track.
Note: The track should look like the first track in Figure 50.
Figure 50 RF Worksheet with Stitched Track
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Note: Each of the file blocks can be manipulated as any other worksheet
including moving them to different tracks and changing the lengths.

11. Once the worksheet is set to a desired configuration, build the RF file.

12. Name the file “Macro12_100ms segments”.

13. Check the file in Spectro-X. Refer to “View Newly Created Signals Using Spectro-X” on
page 11.

14. In Spectro X, set the Time Increment setting to 1.13 msec.

Note: Several segment transitions in the Scrolling Spectrogram screen will be
visible. Notice the lines in the display where the transitions occur.

Note: Max Hold may be used on the Frequency Domain plot to give a picture
of the entire file that was created.
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Figure 51 Stitch File Spectrogram
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